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Installation and maintenance
1 Installation and maintenance
System requirements
Starting the setup program
Installing the program - installation steps
Language Selection dialog box
Welcome dialog box
User Information and User Rights dialog box
Target Folder dialog box
Installation Type dialog box
Starting the installation
Uninstalling or customizing the program
Application Maintenance dialog box

1.1 System requirements
The following hardware and software components are required to install and run the program properly:

• PC, IBM compatible, at least Pentium processor, 166 MHz, 
• 64 MB RAM, 
• 20 MB free hard disk space, 
• SVGA card, at least 256 colors, 
• Windows 98, NT 
• CD-ROM drive for installing the program
• InternetExplorer Version 5.01 or higher

1.2 Starting the setup program
Insert the CD in your CD-ROM drive. The setup program will be started automatically. You can also start 
the setup program manually by following the instructions below: 

On the CD you will find the Setup.exe program in the roots directory.

Double-click on Setup.exe to start the setup program. The Windows Installer dialog box appears. If the 
Windows installer should not yet be available on your system, it is automatically installed then. After this, 
your system needs to be restarted. After the restart the setup program will start again automatically to 
continue the installation. Note: Some systems do not permit an automatic restart of the setup program. 
In this case, manually start Setup.exe as described above. 

1.3 Installing the program - installation steps

1.3.1 Language Selection dialog box
When the setup program has been started, the Language Selection dialog box will pop up. In this dialog 
you can select the language for both theR&C Process Data Management and the installation program.

Select a language from the list and confirm with OK to continue. (Note: The selected language can be the 
same as your system language, but does not need to be). 

1.3.2 Welcome dialog box
A setup wizard started with a welcome screen will help you to install the program. To ensure proper in-
stallation it is strongly recommended to exit all other applications before running the setup program. Be 
sure that this is case before selecting "Next". Otherwise, the current setup procedure should be can-
celled. 
42/49-26 EN Data visualization tool PDV200, R&C Process Data Management Software 5



Installation and maintenance
1.3.3 User Information and User Rights dialog box
Enter your full name and organization in the respective fields. 

Note that special user rights can only be assigned by the system administrator of the PC on which the 
software is to be installed. 

If the menu option "All users" is selected, the program will always appear in the start menu, no matter who 
is currently logged on. 

When selecting the "Me only" option the program will only appear in the start menu when you are logged 
on under your personal account. 

1.3.4 Target Folder dialog box
In this dialog you can define the target drive and folder in which the program is to be installed. Click on 
the "Browse" button to change the default drive and folder. 

1.3.5 Installation Type dialog box
In this dialog box you can select to install Typical, All or Custom products. 

Typical 
Installs the R&C Process Data Management with the following products: Modbus, Visu, Konfi Device 
Type Manager (DTM) for Datavis for device configuration and control (Prog1 and Prog2 functionality) 

All
Installs all products

Custom
Product selection as required. You can select the products you want to install from the next dialog box. 

1.3.6 Starting the installation
When all necessary entries and settings have been made, you can start installation. The installation pro-
cedure may take some time. When installation is complete, a message appears indicating that the instal-
lation was successful. The menu item "R&C Process Data Management " is now available in the start 
menu.

1.3.7 Uninstalling or customizing the program
There are two possible ways to uninstall the program or to install/uninstall specific program components: 

• Start the Setup.exe program or
• Select [Settings -> Control Panel -> Add/Remove Programs] from the Start menu and then double-click 

on the "R&C-Process-Data-Management " option.

In both cases the Setup program is started, and the Application Maintenance dialog box appears.

1.3.8 Application Maintenance dialog box
This dialog box provides several service and maintenance options for your program: 

Customize
Add or remove components

Repair
Re-install or add components that have been purchased at a later time

Uninstall
Completely uninstall the program. 
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Workspace
2 Workspace
R&C Process Data Management Software
Workspace and software concept
Starting the workspace
Workspace components
Project and project tree
Working with the project tree (Edit current project)
Editing the project name
Creating a new element in the project tree
Creating a device
Integrating external applications
Editing remarks
Linked documents
File menu
Creating a new project
Opening an existing project
Saving the current project
Saving a project under a new name
Saving a copy of the project
Sending a project to
View menu
Dialog language
Showing/hiding the toolbar and status bar
Showing/hiding the project view
Project menu
Defining the fieldbus segments
Options
Help Menu

2.1 R&C Process Data Management Software
The R&C Process Data Management Software from ABB Recording & Control includes the following PC 
software packages for measured value processing: 
• Modbus OPC Server (DA 2.0 Standard),
• Device Bus OPC Server (DA 2.0 Standard) for devices that exclusively support the H&B Device Bus 

(from version 3 and higher)
• Process Data Visualization (OPC client)
• OPC HDA Server for recording and handling historical values (from version 3 and higher)
• R&C Process Web Server for process data visualization via the Internet (from version 3 and higher)
• FDT Device Configurator and Device Type Manager for device management and configuration

The following tasks for small automation applications are fully covered by this software: 
• Process data acquisition 
• Archiving (from version 3.0 and higher)
• Visualization
• Device management and configuration

All products of the R&C Process Data Management Software use the following standards and trends of 
advanced process automation: 
• OPC (OLE for Process Control) for process data acquisition, 
• OPC-HDA (Historical Data Access) for process data archiving (Version 3 and higher)
• Web and browser technologies  (HTML, DHTML, JavaScript, ActiveX components technology, etc.) for 

process data visualization
• FDT (Field Device Tool) Standard for device configuration

Due to its compliance with the above-stated standards the R&C Software Suite is an open system pro-
viding the following features: 
• trouble-free cooperation of different software packages
• preservation of you investment in already purchased ABB devices
• integration of bus-compatible devices from other vendors
• integration of OPC servers for other fieldbuses (e.g. Profibus, FoundationFieldbus, InterbusS etc.) 
42/49-26 EN Data visualization tool PDV200, R&C Process Data Management Software 7



Workspace
• free access throughout the network to all process data on recorders, controllers and indicators from pro-
cess control systems or other visualization systems

2.2 Workspace and software concept
All software packages of the R&C Process Data Management Software share a common R&C instrumen-
tation software library. The library is installed with the first product of the software suite, and may be up-
dated if required when a new product of the R&C Process Data Management software package is 
installed. Among other items the library contains all communication components like OPC and FDT. 

To ensure user-friendliness and convenient control all software packages use a common graphical user 
interface, the so-called workspace. This does not apply to the ProcessWebServer which does not need 
a user interface. The workspace is installed with the first product of the software suite, and may be up-
dated if required when a new product of the  R&C Process Data Management software package is in-
stalled.

2.3 Starting the workspace
The menu item "R&C Process Data Management Software " is available in the start menu under "Pro-
grams". Click on the "Workspace" menu item to start the program.

2.4 Workspace components
After starting the workspace the user interface appears (refer to the illustration). The project tree is dis-
played in the left section of the window. It is the main tool for navigating and for controlling the installed 
software packages. Moreover, it is the starting point for all functions related to data acquisition, visualiza-
tion and device parameterization. The right sub-window is the Web browser display area, where any Web 
site selected can be displayed. The installed and licensed software packages are shown here by default.

Fig. 2-1 Work space components
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Workspace
2.5 Project and project tree
The project tree is the main tool for navigating and is used for organizing and handling all devices, plants 
and applications in a structured hierarchy, as seen in the illustration. 

Example
The example shows a plant hierarchy in the project tree. The project may contain any number of folders 
and subfolders. Devices, visualization pages and subfolders can be arranged in every folder such that 
they represent the structure of the actual plant.  

Fig. 2-2

2.5.1 Working with the project tree (Edit current project)
Upon loading or creation of a project the project tree can be designed or adapted freely to meet the re-
quirements of the respective application. You can create hierarchies, change names, and add elements 
like plants, devices, servers or visualization pages. 

Fig. 2-3

All these action can be performed in the project tree. Right-click on the appropriate node in the project 
tree. A shortcut menu adapted to the respective node type appears, where all actions can be performed. 

2.5.2 Editing the project name
Right-click on the root directory. Select "Rename" from the shortcut menu that appears. You can edit the 
project name directly in the tree view, then. 

Note As a rule, every element in the project tree can be renamed in this way.
42/49-26 EN Data visualization tool PDV200, R&C Process Data Management Software 9



Workspace
2.5.3 Creating a new element in the project tree
Right-click on the folder icon to open the shortcut menu. Then select "New". A pull-down menu with var-
ious options for creating a new project element will pop up. The following menu options can be selected: 

Folder
Creates another hierarchy level, where other elements can be. 

Device
Creates a new device. The device type can be selected from a device selection list. The selection list con-
tains all Device Type Managers (DTMs) installed on your PC and the virtual devices like the R&C Modbus 
OPC Server. 

External application
Permits to integrate any external 32-bit program, e.g. Paraline200. This feature is especially designed for 
supporting devices for which no DTM complying with the FDT standard exists yet. 

Visualization page
Permits to create visualization pages by using one of the 11 pre-configured standard visualization pages 
as a template, and to integrate user-defined HTML pages.  

Fig. 2-4

2.5.4 Creating a device
Right-click on the folder icon to open the shortcut menu. Then select "New". A pull-down menu with var-
ious options for creating a new project element will pop up. Select "Device (by type)" to open the dialog 
box for selecting the device type (see the illustration (see Fig. 2-5). 

Fig. 2-5
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Workspace
Select a device from the list of available devices. Press the "Create device" button to confirm. The device 
will be created in the selected folder with the name "New device". Directly upon creation the edit mode 
will be active, i.e. you can change the node name according to your needs. 

Note The name is freely configurable, independent of the device type. Names like "Datavis-1", "Datavis (heater 
A)", or simply "Tag 01" are valid without any limitations.

Double-click on the menu item to start the device-specific Device Type Manager with all parameter defi-
nitions of the device. See topic "Device Type Manager" for details.

2.5.5 Integrating external applications
The program permits to integrate any external 32-bit program, e.g. Parapoint200. This feature is espe-
cially designed for supporting devices for which no DTM complying with the FDT standard exists yet. You 
can also integrate any other 32-bit program, e.g. Excel. 

Right-click on the folder icon to open the shortcut menu. Under "New" a select list for creating a new 
project element can be called up. Select "External application". The dialog box for integrating external 
programs appears.  

Fig. 2-6

Command line
Enter the program name with full path information in the command line.

Work directory:
If you don't want to use the program folder as your work directory, you can enter a path for your work 
directory here.

Confirm with OK. The new item appears in the tree. Double-click on the item to start your application.
42/49-26 EN Data visualization tool PDV200, R&C Process Data Management Software 11



Workspace
Editing remarks
A remark can be stored for every node in the project tree. Select the "Remarks" menu item from the short-
cut menu to open the Remarks dialog box. 
You can enter simple texts without attributes in this dialog box. Confirm with OK. The text is taken over 
and allocated to the node. 

Fig. 2-7

Linked documents
Documents like operating instructions for the device, logs, etc. can be linked with every node. Click on 
the "Linked documents" menu item to open the "Documents linked with this element" dialog box where 
you can add, remove or open documents. 

Fig. 2-8
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Workspace
2.6 File menu
The workspace offers a project management function for creating, loading and saving projects. This al-
lows you to work with different projects. The file menu of the workspace (see illustration) is used for 
project management (see Fig. 2-1).

Fig. 2-9

2.6.1 Creating a new project
In order to create a new project open the File menu and select "New". If you have already opened a 
project and have not yet saved it, you will be asked if you want to save that project before creating a new 
one. If yes the File dialog box appears, if no the current project is closed without saving, and the new 
project is created immediately. 
The new project is first created with the default name "New project", which can be changed as required. 
Refer to the topic "Editing the project name" for details.

2.6.2 Opening an existing project
In order to open an existing project open the File menu and select "Open...". If you have already opened 
a project and have not yet saved it, you will be asked if you want to save that project before opening an-
other one. If yes the File dialog box appears, if no the current project is closed without saving.  The "Open 
file" dialog box appears where you can select the respective file and then load it into the workspace. 
Project files have the extension ".ids".

2.6.3 Saving the current project
In order to save the current project open the File menu and select "Save". The project will be saved with-
out further prompts. If the project is saved for the first time, the "Save as" dialog box will appear, where 
you can enter a new name for your project. 

2.6.4 Saving a project under a new name
Select the "Save as..." menu option from the File menu if you want to save the current project under a 
new name. The "Save as" dialog box will appear, where you can enter a new name for your project. After 
this the project will appear in the workspace under the new name.

2.6.5 Saving a copy of the project
Select the "Save copy as..." menu option from the File menu if you want to save a copy of the current 
project under a new name. The "Save as" dialog box will appear, where you can enter a new name for 
your project. The project name that already exists in the workspace will not be changed. 

2.6.6 Sending a project to
Under "File" -> "Send to" "E-mail address" you can send you project as an e-mail to an addressee. The 
mailing program is opened. A new mail is created automatically, and the project file (.ids) is already at-
tached to it. Enter an e-mail address and send off the mail.
42/49-26 EN Data visualization tool PDV200, R&C Process Data Management Software 13



Workspace
2.7 View menu
In the View menu you can adapt the workspace to your needs. You can select the dialog language and 
show/hide the toolbar, the status bar, and the project tree (Project view). 

Fig. 2-10

2.7.1 Dialog language
Select the "Change language" menu item to change the dialog language. The "Change language" dialog 
window appears.

Fig. 2-11

Select a language from the list of installed languages and confirm with OK. The new language setting will 
be activated when the program is started the next time. Terminate/restart your program. 

2.7.2 Showing/hiding the toolbar and status bar
Click on the "Toolbar" menu item to show/hide the toolbar. 
Click on the "Status bar" menu item to show/hide the status bar.

2.7.3 Showing/hiding the project view
Click on the "Project view" menu item to show/hide. 
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Workspace
2.8 Project menu
In the project menu you can set the project-specific parameters.

Fig. 2-12

2.8.1 Defining the fieldbus segments
A fieldbus segment represents the configuration of serial PC or bus segment interface. If the PC has sev-
eral serial interfaces, you can define several fieldbus segments with different settings (e.g. for the baud 
rate). In the device configuration a fieldbus segment can be allocated to the respective device. 

Select the "Define fieldbus segment" menu item from the "Project" menu. 
A dialog box appears where the defined fieldbus segments are listed. 

Fig. 2-13

Select the name of the link, the protocol (under fieldbus type) and the COM interface in the "Fieldbus seg-
ment" dialog box.

Fig. 2-14
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Workspace
Click on "Edit". 
A window appears, where you can define the interface settings: RS 232 or RS 485, baud rate, etc. 

Remark Usually, RS 232 is the correct setting, even if the device is connected to the RS 232 interface of your 
computer via an  RS 485 converter. RS 485 has to be selected only if a so-called hardware flow control 
is required, e.g. for a non-automatic RS 485/RS 232 converter. 

2.8.2 Options
In the Project options dialog box you can define that the last accessed project is automatically opened 
when the workspace is started.  

Fig. 2-15

2.9 Help Menu
The Help Menu contains the item Help and Register with that one can open the license dialog.

The Help for the License dialog can be opened by pressing the help button avaliable on this dialog.

Comment The Licensing software is a common ABB software independent of the R&C Process Data Management. 
This is the reason why it has his own separate help. 
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OPC visualization
3 OPC visualization
Visualization pages
Creating visualization pages
Configuration and Control
Line chart control
Controlling the line chart
Configuring the line chart
Bargraph display
Configuring the bargraph display
Write functionality
Numeric display
Configuring the numeric display
Write functionality
Meter
Configuring the meter
Channels tab
General tab
Colors/Character sets tab
Cos-Phi display (power factor)
OPC browser

3.1 Visualization pages
The measured process variables can be displayed on either user-defined or standard visualization pages. 
In both cases the visualization is based on the Web Browser technology. The pages are displayed by 
using the Internet Explorer Version 5.01 and higher and can be started and controlled from the program 
(from the project tree, to be more precise). Refer to the information about advanced technologies for de-
tails. Access to the process data is realized via OLE-for Process-Control (OPC). This means the visual-
ization page is a so-called OPC client.

Creating visualization pages
A page generator is available in the program to simplify and speed up the creation of visualization pages. 
Upon selection of the appropriate template the page generator automatically creates a visualization page. 

Follow the instructions to create a new standard visualization page: Right-click on a folder node in the 
project tree to open a shortcut menu. Under "New" a select list for creating a new project element can be 
called up. Select "Visualization page". The dialog box for creating a new visualization page appears.

Fig. 3-1
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OPC visualization
In the upper section of the window you can create visualization pages by using standard templates. Click 
on the respective button to select the appropriate page setup. In the right section of the window you can 
select the display type (so-called visualization elements) for the individual fields. At present a line chart, 
a bargraph, a numeric display and a meter are available. Refer to the respective topic of this help system 
for details. 

Press OK to confirm. The new visualization page will appear in the project tree, and you can edit the name 
according to your needs. 

Double-click on the record in the project tree to start the Internet Explorer and display the new page.

Fig. 3-2

At this stage the visualization elements are still empty. In the next step they  have to be configured and 
linked with the process variables to be displayed.

3.2 Configuration and Control
The display modules (line chart, bargraph display, numeric display and meter) access the process data 
via the OLE-for Process-Control (OPC) mechanism. This means a visualization page is a so-called OPC 
client that accesses the OPC servers on both your local PC and the network. The OPC Browser which is 
also described in detail in this help system is used to select and assign the process variables.
18 Data visualization tool PDV200, R&C Process Data Management Software 42/49-26 EN



OPC visualization
3.2.1 Line chart control
An example for a configured line chart is seen in the illustration. The line chart is made up of the diagram 
area with scales and a value window below it with a list of the configured measuring channels. The toolbar 
on top is used for control.

Fig. 3-3

Controlling the line chart
A list of the current process variables and their properties is indicated below the line chart itself. The list 
can be used to show/hide trend curves be ticking the relevant check boxes on the left hand side. This has 
no effect on measured value acquisition. 

The toolbar indicated on top of the line chart is used for navigation and configuration. The buttons have 
the following functions:

Cursor functionality

When the button is pressed (online mode terminated), the time cursor can be positioned in the dia-
gram with the left mouse button. The  Y-t values of the current cursor position are then indicated in the 
list box.

Stop measured value indication in online mode.  
Data acquisition is still continued, but in the background. When the online mode is terminat-
ed, the scroll functions are active. 

Scroll back (fast) by 50% of the diagram length.

Scroll back by 10% of the diagram length.

Scroll forward by 10% of the diagram length.

Scroll forward (fast) by 50% of the diagram length.

Switch to online display mode. The data collected in the background in the meantime are dis-
played, and the diagram is refreshed with the configured refresh rate.

Zoom in (time).  
Reduces the visible time range to 50% of the current range.

Zoom out (time).  
Extends the visible time range to 200% of the current range.

Configure chart

Export window section data in an ASCII file.

 

Print window section
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OPC visualization
Mouse zoom functionality
[Shift] [left mouse button]: zoom the time range
[Ctrl] [left mouse button]: Y zoom
[Shift] [Ctrl] [left mouse button]: Y-t zoom
When the mouse zoom function is used, the online mode is not active. 

The zoom actions can be undone by actuating the  button. The online display mode remains active.

Scale toggle
Double-click on the scale area to toggle between one scale per channel and single scale display. When 
selecting single scale display, the scale that was double-clicked is displayed.

Show/hide channel
The trend curves can be shown or hidden, as selected by ticking/unticking the checkbox on the left hand 
side in the channel list under the diagram. 

Shortcut menu
Right-click on the line chart to open the shortcut menu seen in the illustration. This menu is used to edit 
the properties and display modes. 

Fig. 3-4
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OPC visualization
Configuring the line chart
Click on the  icon or select "Configure channels" from the shortcut menu to call up the configuration 
dialog box.

Fig. 3-5

The dialog box contains two tabs:  "Channels" and "General". The "Channels" tab is used to configure 
the properties (e.g. color) of each channel. 

Selecting the process variables

Select the  icon to call up the OPC browser which can be used to browse the OPC servers available 
in the system and on the network for the appropriate process variables. The OPC browser is the same 
for all display modules and, therefore, is described as a separate topic. 

Changing the channel properties
Double-click on the respective channel in the list of available process variables to change the channel 
properties. The "Edit item" dialog box appears. 

Setting warning and alarm values
The "Limits active" checkbox is used to enable/disable the warning and alarm values. The warning and 
alarm values are represented in the diagram as horizontal lines. 
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OPC visualization
General tab
The "General" tab is primarily used to make the color and font settings. On this tab you can also set the 
ring buffer time and refresh rate of the chart control. (see the illustration)

Fig. 3-6

Historical time range
The historical time range defines the maximum time range retained in the memory. Older date are over-
written with new ones. The historical time range depends on the refresh rate. A max. value of 7 days is 
possible. 

Refresh rate
Defines the time intervals at which the data in the diagram are refreshed. 

Display time range
Defines the time range indicated in the diagram
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OPC visualization
3.2.2 Bargraph display
The bargraph display can indicate several channels in parallel, as seen in the illustration. 

In addition to the display functionality the bargraph display provides a value write function which can be 
used to download values into the device via the OPC server.

Fig. 3-7

Configuring the bargraph display
Right-click on the bargraph display area to open the shortcut menu. Select "Configuration" from the win-
dow. Except for some items the bargraph display configuration dialog is the same as for the line chart 
(see respective topic). 

Fig. 3-8
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OPC visualization
Setting warning and alarm values
The "Limits active" checkbox is used to enable/disable the warning and alarm values. The bargraph dis-
play indicates limit value through limit lines and color changes of the bar. The colors for normal, warning 
and alarm states can be defined as required for all channels on the "General" tab. On the "Channels" tab 
the limit values can be enabled and set individually for each channel. 

Writeable
The "Writeable" checkbox can be used to enable an additional function for writing values to the OPC serv-
er, or via the OPC server to the device. 

Note Make sure that this feature is also enabled in the OPC server for the respective process variable and that 
the device supports the write function.  
Refer to "Write functionality" for details about control of the bargraph display. 

Selecting the process variables

Select the  icon to call up the OPC browser which can be used to browse the OPC servers available 
in the system and on the network for the appropriate process variables. The OPC browser is the same 
for all display  modules and, therefore, is described as a separate topic.

Changing the channel properties
Double-click on the respective channel in the list of available process variables to change the channel 
properties. The "Edit item" dialog box appears. In this dialog box you can define the name, description 
and unit of the process variables and the range limits of the bars. The ScriptName is only needed for the 
extended properties, e.g. for the creation of freely configurable visualization pages and is not relevant at 
the moment.

Fig. 3-9

Note: The cycle time is the frequency with which the OPC server polls the process variables from the device. 
The refresh rate (defined on the "General" tab) refers to the display frequency of the display. 
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OPC visualization
General tab
The "General" tab is primarily used to make the color and font settings. On this tab you can define the 
display elements and set the refresh time of the bargraph display. (see the illustration)

Fig. 3-10

Write functionality
The write functionality is enabled by ticking the "Writeable" checkbox on the "General" tab and can be 
configured on the "Write" tab.

Fig. 3-11

Write when mouse is moved
When this checkbox is ticked, values are written when the mouse is moved. If the checkbox is not ticked, 
only one value is written when the mouse is released.
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OPC visualization
Define increment
If this checkbox is ticked, the values are incremented or decremented sensitively (fine steps) when the 
mouse is moved. When clicking above or underneath the grab the value is changed non-sensitively 
(coarse adjustment). 
If the "Define increment" function is disabled, the fine adjustment is made at 1% and the coarse adjust-
ment at 10% of the scale.

Control
When the write functionality is enabled, the bargraph is indicated with an additional slide control. In this 
case there are two ways to enter values:
1 Graphical:  

Left-click on the slide control, hold down the mouse button, and move the slide up/down with the mou-
se. You can also click rapidly above or underneath the bar. The value is simultaneously indicated by 
the numeric display. 

2 Numerical: 
Click on the numeric display to switch to the edit mode. Press the RETURN key to confirm/take over 
the value. To cancel the edit action, click outside the edit field or press the ESC key.

The write action to the OPC server is indicated by a "W" displayed in the top left corner of the numeric 
display. If an error occurs, "E" is briefly indicated, and then the previous value is restored.

3.2.3 Numeric display
The numeric display can indicate several channels in parallel, as seen in the illustration. 

In addition to the display functionality the numeric display provides a value write function which can be 
used to download values into the device via the OPC server.

Fig. 3-12

Configuring the numeric display
Right-click on the numeric display area to open the shortcut menu. Select "Configuration" from the win-
dow. Except for some items the numeric display configuration dialog is the same as for the bargraph dis-
play. The "Channels" tab is the same as for the bargraph display.

Selecting the process variables:
Select the   icon to call up the OPC browser which can be used to browse the OPC servers available in 
the system and on the network for the appropriate process variables. The OPC browser is the same for 
all display modules and, therefore, is described as a separate topic.

Changing the channel properties:
Double-click on the respective channel in the list of available process variables to change the channel 
properties. The "Edit item" dialog box appears. In this dialog box you can define the name, description 
and unit of the process variables and the range limits of the bars. The ScriptName is only needed for the 
extended properties, e.g. for the creation of freely configurable visualization pages and is not relevant at 
the moment.
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General tab
The "General" tab contains some special fields for the numeric display, as seen in the illustration.

Fig. 3-13

Colors
Here you can define the foreground and background colors for indicating the normal state, alarms and 
warnings. 

Width
Used to define the width of a display field. This specification refers to the number of M-signs in a line. 
Auto sets this parameter to the default values that depend on the selected font type. 

Format
Used to define the number of lines of the display field. 

Columns
Used to define the number of display fields that can be placed side by side. 

Change font
Upon actuation of this button the Windows "Font" dialog box appears, where you can select the font type 
and set the font parameters. If the Width parameter on the "General" tab is set to "Auto, the size of the 
indicator is automatically adapted to the new font type.

Write functionality
When the write functionality is enabled, the numeric display additionally features an edit function. 

Click on the numeric display to switch to the edit  mode. Press the RETURN key to confirm/take over the 
value. To cancel the edit action, click outside the edit field or press the ESC key.

The write action to the OPC server is indicated by a "W" displayed in the top left corner of the numeric 
display. If an error occurs, "E" is briefly indicated, and then the previous value is restored.
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3.2.4 Meter
The meter is an analog gauge for indicating measured values and signaling warnings and alarms. 

Additionally, this indicator features a special function for indicating the power factor (cos Phi, high-voltage 
current variable) with inductive and capacitive portion. 

The meter can indicate several channels in parallel, as seen in the illustration. 

Fig. 3-14

Configuring the meter
Right-click on the meter area to open the shortcut menu. Select "Configuration" from the window.

Channels tab

Fig. 3-15

Selecting the process variables:
Select the  icon to call up the OPC browser which can be used to browse the OPC servers available 
in the system and on the network for the appropriate process variables. The OPC browser is the same 
for all display function blocks and, therefore, is described as a separate topic.
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Changing the channel properties:
Double-click on the respective channel in the list of available process variables to change the channel 
properties. The "Edit item" dialog box appears. In this dialog box you can define the name, description 
and unit of the process variables and the range limits of the bars. The ScriptName is only needed for the 
extended properties, e.g. for the creation of freely configurable visualization pages and is not relevant at 
the moment.

Cos Phi:
Checkbox for enabling the special power factor display function (cos Phi).

General tab
The "General" tab contains some meter-specific checkboxes, e.g. for showing/hiding graphical display 
elements like main and secondary scale graduation, etc.

Fig. 3-16

Colors/Character sets tab

Fig. 3-17
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OPC visualization
Colors:
Used to select the colors for the display elements and the background colors indicating the normal state, 
warnings and alarms. 

Character set:
Tick the checkbox to enable the setting of the character set for the channel name, value/unit and scale 
legend.

Cos-Phi display (power factor)
Tick the checkbox on the "Channels" tab to enable the Cos-Phi display for the respective channel. 

Actuate the "cos phi" button to open the configuration dialog box.

Fig. 3-18

The ranges can be set in two ways:

• by drawing the small rectangles on the pointer tips with the mouse or
• by directly entering the value in the edit fields (click on the respective field to edit)

The blue pointer is used to define the lower and upper scale end of the Cos-Phi indicator. The red pointer 
defines the alarm range, the yellow pointer the warning range. The normal range is between the two yel-
low pointers.
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OPC visualization
3.3 OPC browser
The illustration shows the OPC browser used for selecting process variables. This browser is identical for 
all OPC display modules.

Fig. 3-19

The OPC address area is indicated in the top left window. Here you can find the network environment 
(Network Neighborhood), your own PC (My Computer) and the available OPC servers in a hierarchical 
structure. In the example you can find  ABB.IM.OpcServer.1 and ICONICS.Simulator.1 on your computer. 

The right window shows a list of the process variables (tags) available on the selected OPC server. 

The bottom window shows a list of the process variables selected for display. 

The OPC server can be controlled with the following buttons:

Press OK to take over the list of selected process variables. They will then be available in the display 
module. 

Take over a selected process variable in the list of selected process variables.

Take over all listed process variables in the list of selected process variables.

Delete an item from the list of selected process variables.

Delete all items from the list of selected process variables.

Edit properties of the selected process variables.
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4 OPC Item Manager
Objects
Class: ImOpcItemMgr
ActivateChanges
Add
Clear
GetServerUnixTime
Items
Items.Count
Items.Item
LoadFromIniFile
OpenBrowseDialog
OpenBrowseDialog2
OpenEditOpcItemDialog
Remove
SaveToIniFile
Class: ImOpcItem
Deadband
Description
GetAccessRights
GetOpcItemProperty (not yet implemented)
Host
ItemId
ReadLocal
ReadUnix
ReadUtc
ScaleHigh
ScaleLow
ScriptName
ServerProgId
Tag
Units
UpdateRate
Value

4.1 Objects
The program package provides 2 objects as ActiveX components, allowing to take full advantage of OPC 
communication. These objects are: the OPC ItemManager, which supports the selection of OPC item IDs 
and controls and executes the communication with the OPC server, and the object OPC Item for data 
access via OPC. 

It is recommended to use the OPC ItemManager only once per application as an object, whereas the 
OPC item object can be used several times for the OPC item IDs. 

Various methods and properties are available for these two objects and are described in this help system. 

If you are using Visual Basic to create a customer-specific application, select   ®Project ®References… 
to call up a dialog box where you can reference these objects after having installed the program package. 
For this purpose select the available reference "ABB OPCClient 1.0".
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OPC Item Manager
4.2 Class: ImOpcItemMgr
ActivateChanges
Add
Clear
GetServerUnixTime
Items
Items.Count
Items.Item
LoadFromIniFile
OpenBrowseDialog
OpenBrowseDialog2
OpenEditOpcItemDialog
Remove
SaveToIniFile

ActivateChanges
Activates all configured OPC item IDs, provided that the parameter is set to True, and activates the be-
longing OPC servers to read the respective data. 

Prior to this activation, other OPC item IDs may still reside in the OPC ItemManager that were active be-
fore the OPC browser has been called up and are no longer needed due to reconfiguration. They are de-
leted only when ActivateChanges is called.

If all changes made in the OPC browser are to be rejected, the parameter must be set to False. 

It is necessary to use this function because the OPC browser can also be used in a another, higher-order 
application, which still permits to Cancel even if the OPC browser itself has been closed with OK. In this 
case all changes in the OPC ItemManager can be rejected by calling ActivateChanges with the parameter 
setting 'False'.

Syntax: MyItemManager.ActivateChanges 
Return value: none 
Parameter: Value as Boolean 
VB example: Set MyItemManager = New ImOpcItemMgr 

….. 
Value = True 
MyItemManager.ActivateChanges Value

Add
Adds an OPC item ID to the OPC ItemManager via an OPC item object. This OPC item ID is then taken 
over and used for processing immediately.

Syntax: MyItemManager.Add OPCItem 
Return value: none 
Parameter: OPCItem as ImOpcItem 
VB example: Set MyItemManager = New ImOpcItemMgr 

….. 
Set OPCItem = New ImOpcItem 
….. 
MyItemManager.ActivateChanges Value 
MyItemManager.Add OPCItem

Clear
Deletes all OPC item IDs from the OPC ItemManager. The OPC servers started by the OPC?ItemMan-
ager are deactivated at this moment. This method cannot be undone by ActivateChanges.

Syntax: MyItemManager.Clear 
Return value: none 
Parameter: none 
VB example: MyItemManager.Clear
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GetServerUnixTime
Provides the current time stamp of a connected OPC server in Unix time format (seconds since 1/1/1970 
incl fractions). This function is used e.g. for Web server applications with PHP. It is normally not needed 
for Visual Basic.

Syntax: Value = MyItemManager.GetServerUnixTime Node, ServerProgId 
Return value: Value as double 
Parameter: Node as string 

ServerProgId as string 
VB example: 'Seconds since 1970-01-01 00:00 

Value = MyItemManager.GetServerUnixTime Node, ServerProgId

Items
Collection of all currently within the OPC ItemManager configured OPC items.
Access to a single item is possible via index (Zero based) by "ScriptName" or within a "For Each" loop.

Syntax: Coll = MyItemManager.Items 
Return value: Collection of all Items 
Parameter: none 
VB example: Set MyItemManager = New ImOpcItemMgr 

MyItemManager.LoadFromIniFile "C:\Temp\Test.ini 
Dim Item As ImOpcItem 
For Each Item In MyItemManager.Items    
MsgBox Item.ItemId & vbTab & Item.Value 
Next Item

Items.Count
Returns the number of OPC items configured and handled in the OPC ItemManager.

If you've deleted OPC item IDs via OpenBrowseDialog, they are also counted as long as ActivateChang-
es was not called.

Syntax: Number = MyItemManager.Items.Count
Return value: Number as Long
Parameter: none
VB example: Set MyItemManager = New ImOpcItemMgr 

……. 
MyItemManager.LoadFromIniFile "C:\Temp\Test.ini 
Number = MyItemManager.Items.Count

Items.Item
Used to access the properties of an OPC item in the OPC ItemManager. The access can be either in-
dexed (zero based) or logical via the ScriptName.
Item is the default property of the Items object and its use is therefore optional.

VB example: MyItemManager.Items.Item(24).ScaleLow or 
MyItemManager.Items (24).ScaleLow
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OPC Item Manager
LoadFromIniFile
OPC item IDs are read from a file and then activated in the OPC ItemManager. The read OPC item IDs 
are not additionally used in the OPC ItemManager, but replace the current configuration. 

A path and a file extension can be specified together with the file name. These specifications are then 
used explicitly. 

Only useful data are read from the file. If the file content has not the structure defined by SaveToIniFile, 
no error is produced. The Items.Count property can be used to determine whether or not OPC item IDs 
have been activated. 

With LoadFromIniFile it is not necessary to call ActivateChanges explicitly.

Syntax: MyItemManager.LoadFromIniFile FileName 
Return value: none 
Parameter: FileName as string 
VB example: Set MyItemManager = New ImOpcItemMgr 

MyItemManager.LoadFromIniFile "C:\TEMP\TEST.INI"

OpenBrowseDialog
Calls the dialog box in which the OPC item IDs for the OPC ItemManager can be selected. 

You can select OPC items from OPC servers on your local or a remote PC. OPC Data Access Servers 
version 1 as well as version 2 can be selected.

The number of selecteable OPC items is specified in the call to OpenBrowseDialog.

The type and destination (local/remote) of the displayed servers must be defined via parameter Selection.

Syntax: MyItemManager.OpenBrowseDialog Selection, number 
Return value: none 
Parameter: Selection as Long 

Number as Long 
VB example: MyItemManager.OpenBrowseDialog 1+2+16, 6

Predefined constants are:
OPCSERVERTYPE_LOCAL 1 Access to locally registered OPC servers 
OPCSERVERTYPE_REMOTE 2 Access to OPC servers addressable via the network  

neighbourhood 
OPCSERVERTYPE_AE 4 Access to alarms and events (not yet implemented) 
OPCSERVERTYPE_DA1 8 Access to data in accordance with OPC-DA Version 1.0 
OPCSERVERTYPE_DA2 16 Access to data in accordance with OPC-DA Version 2.0 
OPCSERVERTYPE_HDA 32 Access to data in accordance with OPC-HDA  

(historical data access) 
OPCSERVERTYPE_ALL_AE 7 Combination of 1 + 2 + 4 
OPCSERVERTYPE_ALL_DA 27 Combination of 1 + 2 + 8 + 16 
OPCSERVERTYPE_ALL_HDA 35 Combination of 1 + 2 + 32

OpenBrowseDialog2
Function identical as OpenBrowseDialog.

As opposed to OpenBrowseDialog this method returns a value of True if the browser dialog was closed 
with OK.

Syntax: MyItemManager.OpenBrowseDialog2 Selection, number 
Return value: none 
Parameter: Selection as Long 

Number as Long 
VB example: Var retValretVal = MyItemManager.OpenBrowseDialog2 1+2+16, 6 

If retVal = True then 
…. Closed with OK 
Endif
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OpenEditOpcItemDialog
Opens a dialog box for editing the properties of an OPC item. The ScriptName is used to select the OPC 
item.

Syntax: MyItemManager.OpenEditOpcItemDialog ScriptName 
Return value: none 
Parameter: ScriptName as string 
VB example: MyItemManager.OpenEditOpcItemDialog "Simulator_Ramp_1__1"

Remove
Removes an OPC item ID from the OPC ItemManager. If an OPC server is no longer needed, maybe 
because it is the only or last reference, the OPC server is terminated automatically. 

The access can be either indexed or logical via the ScriptName .

Note that the index of other OPC item IDs may be changed. 

Syntax: MyItemManager.Remove ScriptName (logic access) 
MyItemManager.Remove Index (indexed access) 

Return value: none 
Parameter: Index as Long OR ScriptName as string 
VB example: MyItemManager.Remove "Simulator_Ramp_1__1"

SaveToIniFile
Saves the currently configured OPC item IDs of the OPC ItemManager into a file. The file can be loaded 
by using the LoadFromIniFile procedure.

A path and a file extension can be specified together with the file name. These specifications are used 
explicitly.

Syntax: MyItemManager.SaveToIniFile FileName 
Return value: none 
Parameter: FileName as string 
VB example: MyItemManager.SaveToIniFile "C:\TEMP\TEST.INI"
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4.3 Class: ImOpcItem
Deadband
Description
GetAccessRights
GetOpcItemProperty (not yet implemented)
Host
ItemId
ReadLocal
ReadUnix
ReadUtc
ScaleHigh
ScaleLow
ScriptName
ServerProgId
Tag
Units
UpdateRate
Value

Deadband
In order to reduce the work load, values for the OPC Item IDs can be transmitted to the OPC client only 
if they differ from the last delivered value by a special tolerance. This tolerance is specified by the Dead-
band property.

The basic setting when creating a new OPC item is 0.1. 

Deadband is writeable/readable.

Syntax: MyItem.Deadband = Value (write) 
Value= MyItem.Deadband (read) 

Data type Value as double

Description
Provides additional information for describing an OPC item. 

The basic setting when creating a new OPC item is an empty string.

Description is writeable/readable.

Syntax: MyItem.Description = Text (write) 
Text = MyItem.Description (read) 

Data type Text as string

GetAccessRights
Provides the current access rights for an active OPC item.

GetAccessRights is read-only. 

Syntax: Value = MyItem.GetAccessRights 
Data type Value as Long

GetOpcItemProperty (not yet implemented)
Returns the property of an active OPC item. The properties of an OPC item object cannot be overwritten 
with this. 

Note that an OPC server does not necessarily provide all properties of an OPC item. 

GetOpcItemProperty is read-only.

Syntax: Vlaue = MyItem.GetOpcItemProperty (property) 
Data type Value as a variantProperty as Long
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Values of the property that have already been pre-defined as constants:
OPCPROP_CDT 1
OPCPROP_VALUE 2
OPCPROP_QUALITY 3
OPCPROP_time 4
OPCPROP_RIGHTS 5
OPCPROP_SCANRATE 6
OPCPROP_UNIT 100
OPCPROP_DESC 101
OPCPROP_HIEU 102
OPCPROP_LOEU 103
OPCPROP_HIRANGE 104
OPCPROP_LORANGE 105
OPCPROP_CLOSE 106
OPCPROP_OPEN 107
OPCPROP_TIMEZONE 108
OPCPROP_DEFAULTDISP 200
OPCPROP_FGC 201
OPCPROP_BGC 202
OPCPROP_BLINK 203
OPCPROP_BMP 204
OPCPROP_SND 205
OPCPROP_HTML 206
OPCPROP_AVI 207
OPCPROP_ALMSTAT 300
OPCPROP_ALMHELP 301
OPCPROP_ALMAREAS 302
OPCPROP_ALMPRIMARYAREA 303
OPCPROP_ALMCONDITION 304
OPCPROP_ALMLIMIT 305
OPCPROP_ALMDB 306
OPCPROP_ALMHH 307
OPCPROP_ALMH 308
OPCPROP_ALML 309
OPCPROP_ALMLL 310
OPCPROP_ALMROC 311
OPCPROP_ALMDEV 312

Host
If an OPC item is to be read from a remote computer connected via the network, Host stands for the name 
of this computer. 

Host is writeable/readable.

Syntax: MyItem.Host = NetworkNodeName (write) 
Node = MyItem.Host (read) 

Data type String

ItemId
Provides the name of the OPC ItemID as it is registered in the server.

ItemId is writeable/readable.

Syntax: MyItem.ItemId = GroupItemName (write) 
GroupItem = MyItem.ItemId (read) 

Data type String
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ReadLocal
Reads the current value for an OPC item ID in the OPC-ItemManager and returns the time in date format. 

The timestamp is automatically corrected according the callers current timezone.

Syntax: MyItem.ReadLocal (Value, LocalTime, Quality) 
Data type Value as variant 

LocalTime as Date 
Quality as Long

ReadUnix
Reads the current value for an OPC item ID in the OPC-ItemManager and returns the time in Unix format 
(seconds since 1/1/1970 incl fractions). This procedure is e.g. used for Web server applications with PHP.

Syntax: MyItem.ReadUnix(Value, UnixTime, Quality) 
Data type Value as Variant 

UnixTime as Double 
Quality as Long

ReadUtc
Reads the current value for an OPC item ID in the OPC-ItemManager and returns the time in UTC format 
(Universal Time Coordinated).

Syntax: MyItem.ReadUtc (Value, UtcTime, Quality) 
Data type Value as Variant 

UtcTime as Date 
Quality as Long

ScaleHigh
The higher scale limit for an OPC item ID. Usually, this limit is used for the scales of bargraph or trend 
displays and is set in the OPC server itself. 

ScaleHigh is writeable and readable.

Syntax: MyItem.ScaleHigh = Value 
Value = MyItem.ScaleHigh 

Data type Value as Double

ScaleLow
The lower scale limit for an OPC item ID. Usually, this limit is used for the scales of bargraph or trend 
displays and is set in the OPC server itself.

ScaleLow is writeable and readable.

Syntax: MyItem.ScaleLow = Value 
Value = MyItem.ScaleLow  

Data type Value as Double
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OPC Item Manager
ScriptName
The ScriptName permits logic access to OPC items without using the index, which may have been 
changed by the Remove procedure. The ScriptName is automatically created by the OPC item object 
when writing to the ItemId property, but can be overwritten at any time by the application. Not allowed 
characters are replaced with underscores.

ScriptName is writeable/readable.

Syntax: MyItem.ScriptName = NewScriptName (write) 
ScriptName = MyItem.ScriptName (read) 

Data type String 

ServerProgId
The name of the OPC server for a specific OPC item.

ServerProgId is writeable/readable.

Syntax: MyItem.ServerProgId = OpcServerProgId (write) 
OpcServerProgId = MyItem.ServerProgId (read) 

Data type OpcServerProgId as string

Tag
The onomatopoeic designation for an OPC item. 

Tag is writeable/readable.

Syntax: MyItem.Tag = NewTag (write) 
NewTag = MyItem.Tag (read) 

Data type Newtag as string

Units
Engineering unit for a single OPC item. 

Units is writeable/readable.

Syntax: MyItem.Units = Unit (write) 
Unit = MyItem.Units (read)

Data type Unit as string

UpdateRate
Cyclic scan rate with which the value of an OPC item is to be refreshed. The unit for the update rate is 
milliseconds. For a 0 deadband this is the rate with which values are delivered from the server. For a 
deadband unequal to 0 this is the maximum rate for signal changes. 

UpdateRate is writeable/readable.

Syntax: MyItem.UpdateRate = Cycle time (write) 
Cycle time = MyItem.UpdateRate (read) 

Data type Cycle time as Long
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OPC Item Manager
Value
Provides the value of an OPC item. For write actions a value is written in this property. For read actions 
no information is provided to the ReadValue procedure about the time stamp and quality. 

When writing it is recommended to check with the ReadValue procedure if a properly working channel is 
already available for communication via the OPC server. 

The data type conversion is made automatically. 

Value is writeable/readable.

Value is the default property of the Item object and is therefore optional.

Syntax: MyItem.Value = WriteValue (write) 
ReadValue = MyItem.Value (read) 
ReadValue = MyItem (read, simplified) 

Data type WriteValue/ReadValue as Variant
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